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Read Me First 
Welcome to Take Control of Apple Mail, Fifth Edition, version 5.2, 
published in July 2022 by alt concepts. This book was written by Joe 
Kissell and edited by Kelly Turner. 

This book helps you understand the most effective ways to use Apple’s 
Mail app in macOS 12 Monterey, macOS 11 Big Sur, macOS 10.15 
Catalina, or 10.14 Mojave, and iOS 15/iPadOS 15 or iOS 14/iPadOS 14, 
including customization and troubleshooting. It also helps you manage 
your incoming and outgoing email efficiently. 

If you want to share this ebook with a friend, we ask that you do so 
as you would with a physical book: “lend” it for a quick look, but ask 
your friend to buy a copy for careful reading or reference. Discounted 
classroom and Mac user group copies are available. 

Copyright © 2022, Joe Kissell. All rights reserved. 

Updates and More 

You can access extras related to this ebook on the web (use the link 
in Ebook Extras, near the end; it’s available only to purchasers). On 
the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy 
any subsequent edition at a discount. 

• Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

• Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

If you bought this ebook from the Take Control website, it has been 
added to your account, where you can download it in other formats 
and access any future updates. 
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What’s New in Version 5.2 

Version 5.2 updates the book to cover macOS 12 Monterey, iOS 15, and 
iPadOS 15: 

• Discussed the iCloud+ feature that lets you use your own domain 
name with iCloud Mail; see the sidebar What About Custom Do-
mains? 

• Added a sidebar, Restoring Missing Columns, that explains how to 
enable “missing” columns in Column Layout in Big Sur and later 

• Explained the new Mail Privacy Protection and Hide My Email 
features in Mail; see Improve Your Privacy 

• Discussed the new Mail extensions; see Understand Plugins vs. 
Extensions and Use Extensions (Monterey and Later) 

• Added a sidebar about the Shortcuts app: What About Shortcuts? 

• Included a note in Add Your Gmail Account about using OAuth with 
a Google account. 

• Added a sidebar (Which Reply Icon?) explaining the two different 
Reply icons in Mail for iOS 

• Dropped explicit coverage of iOS 13, while continuing to cover iOS 
14 and iPadOS 14 

What Was New in Version 5.1 

Version 5.1 of this book contained a number of revisions, most notably 
the following: 

• Described the (fairly minor) functional changes in macOS 11 Big 
Sur, as described in Mail Changes in Big Sur. 

• Covered the modest changes in iOS 14/iPadOS 14, listed in Mail 
Changes in iOS 14 & iPadOS 14. 
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• Replaced a fair number of screenshots with versions that depict Big 
Sur, where the visual difference was significant enough that it 
seemed important to highlight. The remaining Mac screenshots, 
which show Mail in Catalina, are reasonably similar to what appears 
in Monterey. 

• Dropped explicit coverage of iOS 12, while continuing to cover iOS 
13 and iPadOS 13. 

What Was New in the Fifth Edition 

Version 5.0 of this book covered the changes to Mail in macOS 10.15 
Catalina (see Mail Changes in Catalina) and iOS 13/iPadOS 13, while 
removing details specific to 10.13 High Sierra and iOS 11. The most 
noteworthy changes were: 

• Added a sidebar, Syncing Other Mail Data with iCloud, about 
various data other than messages themselves that Mail can sync 
across devices 

• Added a warning about a bug that can cause data loss in Catalina; 
see Filing 

• Updated the descriptions of Markup and Continuity Camera to 
cover changes in Catalina, and added coverage of Continuity Sketch 

• Described exactly what’s wrong with Column Layout (Catalina), 
even though there’s not much you can do but avoid it 

• Updated Use Third-Party Plugins and Noteworthy Plugins to elimi-
nate plugins that are incompatible with Catalina, and to provide 
information on current plugin behavior 

• Explained how to Mute Conversations in Catalina 

• Described the new unsubscribe feature in Unsubscribe from Mailing 
Lists 

• Added information on blocking senders in Set Mail’s Junk Mail 
Filter Correctly 
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• Completely revised Get a Personal Certificate and Set Up S/MIME 
in iOS & iPadOS to provide instructions for using Actalis to obtain, 
install, and use a free certificate 

• Returned the discussion of Bangs to the troubleshooting chapter 

• Reorganized and greatly expanded Use Mail in iOS & iPadOS to 
cover the many feature and interface changes to Mail in iOS 13 and 
iPadOS 13 
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Introduction 
If Apple Mail is your email client of choice under macOS 10.14 Mojave 
or later, or iOS 14/iPadOS 14 or later, this book will help you get more 
out of it. You’ll understand the app better, learn useful tricks and 
techniques, and become a more effective correspondent. I hope and 
expect that, by the time you finish this book, you’ll be a happier Mail 
user. 

And yet, I must be candid: I’m a lot less happy with Mail than I used to 
be, and getting unhappier still with each new version. 

The reason I wrote Take Control of Email with Apple Mail back in 
2004 (and eight subsequent editions under various titles) was to help 
Mail users solve problems and eliminate frustrations. Unfortunately, in 
recent years, Apple hasn’t merely removed useful features (see Mail’s 
Disappearing Features), added bugs, and made irritating changes to 
Mail’s user interface. In revising Mail’s infrastructure, Apple has also 
made it difficult, and sometimes impossible, to solve problems—and 
often there’s nothing I can do about it. 

I can’t tell you how many times someone has begged me for help with a 
Mail problem, and all I could do was say, “It’s not you. It’s Apple. This 
isn’t a problem you can solve. I’m so sorry.” The fact is, when it comes 
to the bugs, missing features, and inexplicable behavior in recent 
versions of Mail, I’m struggling as much as you are. I keep hoping for a 
major revision to Mail that will finally set things right, but year after 
year, I am disappointed. 

For now, however, I’ll help you as much as I can. In this book, I explain 
how features are supposed to work and describe the best ways to 
accomplish common email tasks. I also help you to avoid, fix, or work 
around as many problems as I can. And I tell you what I’ve done to 
make Mail work better for me (often through the use of third-party 
plugins). 
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It’s worth asking here why, if Mail is so annoying, I don’t simply switch 
to some other email app and recommend that others do the same. My 
answer to this for quite some time has been that, even with all its flaws, 
Apple Mail still works better for me than any alternative I’ve tried (and 
I’ve tried many). Given the ways I’ve customized my settings, and the 
third-party plugins I’ve added, I haven’t yet found another app that 
gives me all the capabilities I’ve come to depend on in Mail. 

Note: My friends at SmallCubed Software, developers of the Mail-
Suite plugin I’m so fond of, are working on a new full-featured email 
client called MailMaven that includes all the capabilities currently 
found in MailSuite (and much more). Could this finally be the email 
app that lets me give up Mail for macOS? Time will tell! 

Mail under iOS and iPadOS, while less powerful, is remarkably good 
and—despite a few missteps—getting better. The biggest issue with the 
mobile version of Mail is that, like most mobile email clients, it still 
lacks many of the useful features found in the desktop version, which 
means iOS/iPadOS users will need to develop a strategy that takes 
those differences into account. 

Regardless of which Apple platform(s) you use, this book is about how 
to do useful things with Mail—how to bend Mail to your will (to the 
extent possible) and feel as though you are genuinely in control of your 
email. But this isn’t a comprehensive reference guide: I’ll largely ignore 
basic tasks that you either know how to do already or can figure out 
easily by consulting the Help menu. I’m assuming you already know 
your way around an email client and mainly want guidance with less-
than-obvious tasks and features. 

Several chapters apply equally to Mail in macOS and iOS/iPadOS, but 
most of the book focuses on Mail on the Mac, which is only right, since 
it has far more features (and problems) than the mobile version. 
The final chapter, Use Mail in iOS & iPadOS, covers the differences 
between the two platforms as well as the special strengths, weaknesses, 
and idiosyncrasies in the mobile version of Mail. 
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Apple Mail Quick Start 
You can jump right to any topic of interest, but I suggest starting with 
the first few chapters to get a solid foundation. Chapters are marked 
with [macOS] and/or [iOS & iPadOS] to show the platforms they cover. 

Understand what you’re dealing with: 
• Discover Mail’s new features and design changes. Read Learn 

What’s New in Mail. [macOS/iOS & iPadOS] 

• Get a grip on POP, IMAP, SMTP, Exchange, and more as you Learn 
About Email Protocols. [macOS/iOS & iPadOS] 

• Make sure you understand account-setup details and how Mail 
deals with common tasks. See Master Mail Concepts. [macOS] 

Find the ideal Mail setup for your needs: 
• Tailor Mail to your needs and tastes with settings, shortcuts, plug-

ins, and more as you Customize Mail. [macOS] 

• Take Mail even further. See Extend and Automate Mail. [macOS] 

• Gmail user? You’re in for some weirdness, so there’s a whole chap-
ter just for you: Use Gmail with Mail. [macOS] 

Become a better Mail user: 
• Search like a pro. Read Find Your Messages. [macOS] 

• Manage incoming and saved messages as you Take Control of Your 
Inbox, and then learn the best ways of sending and replying to email 
in Become a Better Correspondent. [macOS/iOS & iPadOS] 

Handle exceptional tasks: 
• Sign and Encrypt Messages for privacy. [macOS/iOS & iPadOS] 

• Perplexed by an error message or other misbehavior in the Mac 
version of Mail? Read Fix Mail Problems. [macOS] 

• Make the most of Mail on your iPhone, iPad, or iPod touch. See Use 
Mail in iOS & iPadOS. [iOS & iPadOS] 
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Learn What’s New in Mail 
The versions of Mail in Monterey, Big Sur, Catalina, Mojave, and iOS 
14/iPadOS 14 and later contain new features and design changes 
compared to earlier versions. Skim this chapter to see which of these 
may be important to you. But first, please indulge me in a brief rant. 

Mail’s Disappearing Features 
With each new version of macOS, Apple adds some things to Mail and 
changes some things. More often than not, Apple also removes useful 
features—often for no apparent reason. Losing the occasional minor 
feature is usually no big deal, but the cumulative effect over many 
years has been to sap Mail of much of its power and flexibility. Just a 
few of many examples: 

✦ In 11.0 Big Sur, some unified mailboxes disappeared from Fa-
vorites by default (though you can replace them manually). 

✦ In 10.15 Catalina, Mail lost its “classic” view and gained a severely 
broken Column layout. (This was fixed in macOS 11 Big Sur.) 

✦ In 10.14 Mojave, stationery support was dropped. 

✦ In 10.11 El Capitan, Apple removed the option to cancel individual 
tasks in the Activity window, and severely reduced the utility of 
the Mail Activity pane at the bottom of the sidebar. 

✦ In 10.10 Yosemite, Mail stopped allowing you not to cache all mes-
sages locally, if that was your preference. 

✦ In 10.9 Mavericks, it became impossible to switch between plain 
text and rich text versions of incoming messages, or to specify 
plain text as the default with a special command in Terminal. 

✦ In 10.8 Mountain Lion, notes were moved from Mail to the new 
Notes app, while RSS support was removed from both Mail and 
Safari, with no built-in replacement offered. 

✦ In 10.7 Lion, Mail lost built-in support for reminders, as well as a 
feature that let you manually bounce messages. 

Even as Apple removed features that worked, the company added 
bugs to both new and existing features. I mention some later. 
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Mail Changes in Monterey 

Mail had just a handful of changes in Monterey, and if you were 
already using the Big Sur versions, you might not even notice them 
unless you look carefully: 

• Mail now has a privacy feature that makes it more difficult for 
companies to track you via your email; see Use Mail Privacy Protec-
tion. 

• In addition to plugins, Mail now supports extensions, which use a 
new mechanism to give third-party apps the capability to alter 
Mail’s behavior; see Understand Plugins vs. Extensions and Use 
Extensions (Monterey and Later). 

• Apple added a keyboard shortcut for toggling the sidebar; see 
Sidebar. 

• For iCloud+ subscribers, Monterey now offers a Hide My Email 
feature, which is accessible from within Mail; see Hide Your Email 
Address. 

Mail Changes in Big Sur 

Although Mail, like most other apps, looks quite a bit different in Big 
Sur than in Catalina, it’s very close in functionality. Only a few signifi-
cant changes occurred—mostly for the better: 

• Like other apps, Mail adopts a full-height sidebar (see Decoding the 
Mail Sidebar and Sidebar) and an annoyingly configured toolbar 
(see Toolbars), both of which feature numerous revised icons. 

• The Favorites list, which takes over the duties of the sidebar’s 
Mailboxes list in Catalina and earlier, behaves a bit differently; see 
Favorites. 

• For some users, the All Trash and/or All Junk unified mailboxes 
don’t appear, by default, in the sidebar’s Favorites list. You can, 
however, restore them; see Favorites in the Sidebar. 
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Learn About Email Protocols 
The word “protocol” may sound complicated, but it’s just a way of 
describing how your email program (in this case, Mail) talks to a mail 
server. If you know a few basics about email protocols, you’ll have an 
easier time understanding Mail’s interface and solving problems. 

Although you may not be aware of it, most email accounts involve two 
separate systems—one for receiving and another for sending—and 
these often use entirely different servers. You probably use the same 
username and password for each, but behind the scenes, each account 
may function as two separate accounts: 

• Your incoming account fetches email from your mail server and 
delivers it to you using a mail delivery protocol—such as POP (Post 
Office Protocol) or IMAP (Internet Message Access Protocol). Just 
ahead, I explain more about POP and IMAP, I discuss common 
IMAP and POP Misconceptions, and I offer guidance if you’re still 
using POP and want to Switch from POP to IMAP (you probably 
do). I also mention a few important points about iCloud and Gmail 
accounts, both of which also use IMAP. 

• Your outgoing account uses a mail transfer protocol called SMTP 
(Simple Mail Transfer Protocol) to send email from your machine to 
your mail server, and then (usually through a number of intermedi-
ate steps) to the recipient’s mail server. 

Microsoft Exchange accounts are a bit different. They act like IMAP 
accounts in many ways, but use a single—and an entirely different— 
protocol for receiving and sending mail, as well as calendar items, 
contacts, and other information. 

Note: In this book I refer to IMAP (including iCloud and Gmail) 
accounts and Exchange accounts, which manage and work with 
messages on the mail server, as server-based accounts to distinguish 
them from POP accounts, which store all retrieved messages locally. 
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In this chapter I also discuss the concepts Fetch, Push, and IMAP 
IDLE, which apply to multiple account types and affect how rapidly 
your email client can find out about new messages. 

POP 

A POP account works like this: 

• First, your client (that is, your email program) asks the server for 
the list of messages in your Inbox. 

• Then, depending on your client’s capabilities and settings, it down-
loads either all the messages, just the messages you select, or all 
messages under a specified size, to your local device. 

• Finally (and optionally), your client instructs the server to delete 
the server copy of some or all of the messages. 

The server doesn’t keep track of whether a message has been down-
loaded, read, or deleted; only your client knows this, and the assump-
tion underlying the protocol is that you want to read, organize, and 
store your mail on a single device, using the server only as a conduit to 
receive your mail. If you want to store any messages in mailboxes other 
than your Inbox, when you create those mailboxes in your email client, 
they’re stored locally (not on the server); the messages you move to 
these mailboxes are thus also stored locally. 

You can usually set your client to leave messages on the server (rather 
than delete them immediately after retrieving them) and then check 
your email with a different client (or on a different device), but all 
those messages will appear to be “new” and unread on every other 
client or device. This, among other reasons, makes POP a poor option 
if you work with email on multiple computers and devices. 

In addition, although iOS and iPadOS support POP, the mobile version 
of Mail doesn’t let you create new mailboxes to file messages locally. 
That means an iOS device doesn’t work well as the sole device used 
with a POP account, and because POP works best when used with a 
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Master Mail Concepts 
As I said in the Introduction, this book isn’t about basics, as such. 
However, as I’ve corresponded with many Mail users over the years, 
I’ve discovered that there are certain concepts that Apple hasn’t made 
self-explanatory, and that therefore tend to trip people up. In order 
to understand and act on much of the rest of this book, you need to 
grasp a few concepts that are, perhaps, unnecessarily confusing. In this 
chapter I walk you through the ones I consider most important. 

Most of the items in this chapter pertain only to the Mac version of 
Mail, but if you’re an iOS or iPadOS user, be sure to read Special 
Mailboxes, much of which is also applicable to iOS/iPadOS. 

Account Setup 

Setting up new accounts in Mail is pretty easy, especially if you’re using 
one of the major email providers Mail already knows about (iCloud, 
Exchange, Google/Gmail, Yahoo, and AOL)—almost the entire proce-
dure is automated. However, there are still a few gotchas, especially if 
you’re using a different provider. 

Pick a Preference Pane 
For starters, there are two places where you can add, edit, or remove 
accounts: in Mail > Preferences > Accounts (or, just for adding ac-
counts, the shortcut Mail > Add Account) and in System Preferences > 
Internet Accounts (which you can also reach from within Mail by 
choosing Mail > Accounts). 

Why two places, and when should you use which? 

• The reason for the System Preferences > Internet Accounts pane 
is twofold. First, many account types (including iCloud, Exchange, 
and Gmail) include more features than just email, and affect more 
apps than just Mail, so Internet Accounts provides a central location 
where you can enable or disable individual data types like Mail, 
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Calendars, Contacts, and Notes for each account. Second, some 
account types (like Twitter and Facebook) are used by macOS but 
not by specific, built-in apps, and so it makes sense to provide one 
central location to set up all these accounts. 

• The reason for the Mail > Preferences > Accounts pane is, of course, 
to make it more convenient to add an email account when you’re 
already working in Mail—and because you may need to configure 
any of numerous email account settings that are specific to Mail, 
and that therefore would be inappropriate for Apple to put in 
System Preferences. 

You can add a new account to Mail in either place, and after you do 
so, both locations will reflect that account. Beyond that, the System 
Preferences > Internet Accounts pane gives you less control over the 
minute details of email account settings than Mail’s Accounts pane 
does, although there are a couple of things you can do only in Internet 
Accounts. 

Here are the specifics: 

• Mail > Preferences > Accounts: Visit this pane to edit outgoing 
(SMTP) servers, add secondary From addresses, change the behav-
ior of Special Mailboxes, and adjust details such as whether to 
download attachments or use an IMAP path prefix. 

• System Preferences > Internet Accounts: Use this to enable 
or disable account features such as Calendars and Contacts, to 
delete any accounts synced via iCloud, or to set up internet accounts 
that don’t involve Mail. 

Tip: Even though Mail should, and usually does, configure all your 
settings correctly automatically, somethings things go kerflooey. So 
Apple offers a simple web-based tool that lets you enter your email 
address and—if your provider is among the most common ones— 
displays basic settings for your account such as the IMAP and SMTP 
server names, server ports, and authentication methods. 
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Customize Mail 
Mail isn’t the fanciest or most powerful email client for the Mac, and 
many people have dismissed it as being too unsophisticated for email 
power users. I agree with that sentiment to a point—in its default 
configuration, Mail isn’t a fantastic email program. However, you can 
customize Mail in many ways, including by adding plugins that both 
dramatically increase its capabilities and modify standard behaviors 
to become much more useful. The result is that with a bit of effort, you 
can turn a so-so email client into a deluxe and highly optimized tool. 

In this chapter, I acquaint you with some of the most important ways 
to customize Mail that don’t require any additional software. I don’t 
list every single option, nor do I go into tremendous detail, but I want 
to make sure you’re aware of what so many Mail users aren’t—you 
don’t have to live with the stock version of Mail, and you can improve 
your enjoyment of the app a great deal with a bit of grooming. 

Note: Later, in Extend and Automate Mail, I discuss third-party 
plugins, AppleScript, Automator, and other ways of enhancing Mail. 

Sidebar 

The sidebar is the area on the left of Mail’s main window that contains 
all your mailboxes. Don’t see it? Choose View > Show Mailbox List. 
Prefer to keep it hidden? Choose View > Hide Mailbox List. Starting in 
macOS Monterey, you can also use ⌘-Control-S to toggle the sidebar. 
(Apple seems to think Mail is easier to use when the sidebar is hidden, 
but for most people with multiple accounts or more than a few mail-
boxes, the sidebar is indispensable.) 

Note: SpamSieve uses ⌘-Control-S as the shortcut for the command 
Message > SpamSieve - Train as Spam, but it helpfully changes the 
shortcut for toggling the sidebar to ⌘-Option-S. 
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You can make the sidebar wider or narrower by dragging the line that 
divides it from the message list. If the icons in the sidebar (and their 
associated text labels) are larger or smaller than you prefer, go to 
System Preferences > General and choose a different size from the 
“Sidebar icon size” pop-up menu; but note that this setting affects 
sidebars all throughout macOS. 

You can also rearrange items in the sidebar by dragging them to new 
locations, with certain limitations: 

• Top-level categories (such as Favorites or Mailboxes, where your 
Special Mailboxes are; Smart Mailboxes; and individual accounts) 
can be reordered—for example, you might want to show your smart 
mailboxes at the top of the list and your special mailboxes at the 
bottom. 

• Within the Favorites category in Big Sur or later, items can be re-
ordered or hidden; see Favorites in the Sidebar just ahead for 
details. 

• Within the Mailboxes category in Catalina or earlier, the order of 
(unified) special mailboxes is fixed; for example, Drafts always 
appears above Sent. However, you can reorder accounts within a 
unified special mailbox. For example, if your Gmail account is listed 
before iCloud under Sent, you can drag iCloud above Gmail—and 
that modified order will be reflected under all your unified special 
mailboxes. 

• You can reorder the mailboxes within any given account. 

• You can click the disclosure icon (in Big Sur or later) or Show or 
Hide (in Catalina or earlier) next to a sidebar category to expand or 
collapse its contents (see Hidden Interface Elements), but you can’t 
manually hide the categories themselves. On the other hand, Mail 
automatically hides the names of accounts that have no sub-mail-
boxes beneath them. 

Mail used to have a Mail Activity pane at the bottom of the sidebar. It’s 
gone now, but an abbreviated version (Figure 10) appears briefly in 
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Improve Your Privacy 
Email is not the most private means of communication, as messages 
are normally unencrypted and subject to interception and inspection in 
a variety of ways. I cover how to use encryption with Mail in Sign and 
Encrypt Messages, later. Here, however, I want to draw your attention 
to two privacy-related features introduced in macOS 12 Monterey and 
iOS 15/iPadOS 15: Mail Privacy Protection and Hide My Email. Both 
attempt to reduce the amount of personal information you expose 
while using email. 

About iCloud+ 
iCloud+ is Apple’s newish term for their paid tiers of iCloud storage, 
ranging from 50 GB to 2 TB. Starting in late 2021, anyone paying for 
the extra storage also gets a bunch of other features relating to 
privacy and security. 

For the purpose of this book, the only features that require iCloud+ 
subscriptions are Hide My Email (see Hide Your Email Address, later 
in this chapter) and custom email domains (see the sidebar What 
About Custom Domains?). 

Use Mail Privacy Protection 

The new Mail Privacy Protection feature introduced in Monterey and 
iOS 15/iPadOS 15 makes it more difficult for people and companies to 
track you through email. (At least it does in theory; read on for a 
significant qualification.) 

When you enable this feature, by default, Mail downloads any remote 
images in email messages in the background, using an obscured IP 
address. This means that, if the message includes a tracking pixel (with 
a user-specific string at the end of its address), loading the image 
signals to the sender that you opened it, but not precisely when you 
opened it, how many times you opened it, where you opened it, or 
whether you forwarded it. (And, because the sender doesn’t know your 
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Mac’s real IP address, they can’t use that, in combination with web 
tracking, to build up their profile of your behavior.) 

Because tracking pixels are ubiquitous and a lot of people consider 
email tracking to be creepy, it’s nice to have a feature that gives 
senders less information about you. 

To enable Mail Privacy Protection, do the following: 

• macOS, Monterey or later: Go to Mail > Preferences > Privacy 
and select Protect Mail Activity. 

• iOS 15/iPadOS 15 or later: Go to Settings > Mail > Privacy 
Protection and turn on Protect Mail Activity. 

However, weirdly, Mail Privacy Protection still does load those track-
ing images, and therefore still does tell the sender that you, specifical-
ly, received the message. If the sort of privacy you’re looking for 
includes hiding from senders the fact that you received and opened 
their messages at all, you won’t get that without some extra effort. To 
do so, counterintuitively, you have to disable Protect Mail Activity in 
the above locations. Once you do so, two more options appear: 

• Hide IP Address: This feature sends any requests for remote 
content (typically embedded images, which may include the invisi-
ble tracking pixels) through proxy servers to prevent the sender 
from knowing your IP address and location. In other words, this is a 
portion of Mail Privacy Protection, but not including the automatic 
background loading feature. I suggest enabling this feature. 

• Block All Remote Content: This setting prevents Mail from 
downloading embedded images and other content automatically at 
all, though you can still load such images manually, if you like. I 
also suggest enabling this feature. 

Note: In previous versions of Mail, there was a checkbox called "Load 
remote content in messages," which, when unchecked, did exactly 
what Block All Remote Content does. I recommended then, and still 
recommend now, using this feature rather than the full Mail Privacy 
Protection, which actually provides less privacy! 
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Extend and Automate Mail 
If I had to use the plain, unadorned version of Mail as Apple provides 
it, my productivity and happiness would decrease significantly—and 
I’d probably switch to another app in short order. But with the addition 
of a few third-party plugins and other tools, Mail becomes vastly more 
versatile and powerful. 

In this chapter, I want to introduce you to some of the many ways you 
can extend Mail’s capabilities. First, I’ll show you a selection of plugins 
that can add or modify features. For anyone who needs to save and 
search messages outside Mail, I next turn to apps that can Archive and 
Search Messages, and then tell you about utilities to Remove Duplicate 
Messages. I wrap up the chapter with an introduction to the ways you 
can Use AppleScript and Automator to automate Mail. 

There’s a lot of information in this chapter, and I don’t want you to 
think you need each product I mention. (In fact, some of them would 
overlap and possibly conflict with each other.) Rather, my intention is 
to acquaint you with a representative sample of the possibilities. 

Joe’s Favorites 
If you’re curious which of the tools from this chapter I use myself, 
here’s my list of personal favorites: 

✦ AppleScript 

✦ DEVONthink (see Archive and Search Messages) 

✦ GPG Mail 

✦ MailSuite (in particular, Mail Act-On and MailTags) 

Understand Plugins vs. Extensions 

For many years, developers have been able to add features to Mail for 
macOS by writing special apps called plugins (see Use Third-Party 
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Plugins). Plugins can be quite powerful, altering the way Mail receives 
and sends messages, adding useful new interface elements and menu 
commands, and remedying missing or poorly implemented features. 

However, for whatever reason, Apple has offered only grudging sup-
port for plugins. With each major release of macOS in recent years, 
Apple has made it progressively harder for plugins to function, limited 
the scope of what they can do, and made life more difficult for both 
developers and users of plugins. (In addition, plugins must be revised 
in at least a small way for every minor release of macOS—another 
seemingly pointless hassle.) 

All that was supposed to change with Monterey, when Apple an-
nounced a whole new architecture for third parties to interact with 
Mail: extensions (see Use Extensions (Monterey and Later)). The idea 
was that extensions—with their promised improvements and more 
explicit approval from Apple—eventually would be the only supported 
way of extending Mail in the future. (Though, as far as I can tell, 
plugins will still work in macOS 13 Ventura.) 

The framework developers use to create Mail extensions is called 
MailKit, though you as a user may never encounter that term, and 
Apple’s documentation makes it sound as though extensions can do 
nearly anything. Unfortunately, many types of functionality currently 
available in third-party plugins can’t be achieved with the new exten-
sions, and developers have not exactly been jumping on the extensions 
bandwagon. So my best guess is that, at whatever point in the future 
plugin support finally goes away, Mail will simply lose a great many 
capabilities that could be added only by plugins. A sad day that will be. 

Use Third-Party Plugins 

Numerous third-party Mail plugins exist. These enable you to change 
unwanted behaviors, add new features, and enable significant new 
customization options. For example, plugins can stop spam, encrypt 
email messages, offer advanced message filing options, change the way 
attachments are handled, and much more. 
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Use Gmail with Mail 
If you have a Gmail account and want to use it in Mail under macOS, 
this chapter is for you. I cover the ways Gmail in Mail differs from 
Gmail on the web, the ways Gmail differs from other IMAP providers, 
how best to configure Mail to use a Gmail account, and how to avoid 
common problems. All of this, I hope, will help make your experience 
of using Gmail in Mail as good as it can be. 

Note: Everything in this chapter applies equally to standard Gmail 
accounts and to Google Apps accounts with a custom domain name. 

If you don’t use Gmail (or don’t want to use Mail to access Gmail), 
there’s nothing to see here. Move right ahead to Find Your Messages. 

Understand How Mail Works (or Not) 
with Gmail 

If you’re accustomed to Gmail’s web interface, you may expect it to 
work similarly in Mail. On the other hand, if you’re used to using Mail 
with other IMAP accounts, you may expect Gmail accounts to behave 
the same way. In both cases, the reality will differ quite a bit from your 
expectation, and you’ll have an easier time using the combination of 
Mail and Gmail if you know more up front about how the two systems 
try (and sometimes fail) to work together. I’ll start by reviewing the 
basics of how Mail interacts with Gmail, then discuss Gmail on the 
Web vs. Gmail in Mail, and finally turn to Gmail vs. Other IMAP 
Providers. 

Note: Although Mail can also access Gmail via POP, I recommend 
against it and don’t cover it in this book. Among other issues, with 
POP, Mail can’t see archived Gmail messages or messages you’ve sent 
from your Gmail account using the web interface. 
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Years ago, I used Gmail as my main email provider, and after quite a 
bit of experimentation, I figured out a rather involved way to make 
Mail behave the way I wanted it to with my Gmail account. Then, with 
Mac OS X 10.9 Mavericks, Apple made a bunch of changes to the way 
Mail worked with Gmail that were supposed to solve problems (and 
prevent the need for the complex procedures I’d worked out) but 
actually made the situation much worse. After some drama, Apple 
eventually set things right, and now—to the extent that these two quite 
different ways of approaching email can be reconciled—Mail usually 
works pretty well with Gmail accounts. 

Note: Although I still have a Gmail account, I almost never use it, 
and it’s certainly not my main account. At the time I stopped using 
Gmail as my main provider, I described my decision in Why (and 
how) I’m saying goodbye to Gmail. Nowadays, I have additional 
reasons to avoid Gmail, including a fundamental dislike of Google’s 
business model. But that’s me. 

In general, you’ll get the best results if you have Mail and Gmail 
configured in the way they expect (see Set Up Mail to Use Gmail). But 
since your options for configuring the way Mail works with Gmail are 
more limited than in years past, if you follow the instructions in this 
chapter and still can’t get the results you want, I’m afraid my only 
advice is to ditch either Gmail (in favor of a conventional IMAP or 
Exchange provider) or Mail (in favor of Gmail’s web interface or a 
client designed expressly for Gmail). 

Gmail on the Web vs. Gmail in Mail 
Gmail started as a web-only email system; POP and IMAP access were 
tacked on later. As a result of its web focus, Google designed Gmail to 
handle email in a fundamentally different way from conventional email 
servers. Although I don’t care for Gmail’s model, I understand why a 
lot of people prefer it—but unfortunately, it’s a way of looking at email 
that Mail can’t entirely replicate. Here are some of the key differences: 

• Labels vs. mailboxes: On the Gmail website, you can apply 
descriptive labels to each message to help you find messages with 
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Find Your Messages 
The Spotlight search feature in macOS automatically indexes all your 
Mail messages for super-fast searching, either from within Mail or 
using the system-wide Spotlight menu. 

You can search using natural language rather than relying on special 
keywords or formulations. However, if you want to do complex search-
es, you can. With a flexible system of search tokens (which I explain in 
a moment), Boolean searches, and other options, you can find almost 
any message you can describe. 

And, you can even save a search by converting it into a smart mailbox, 
as I describe at the end of this chapter, in Work Smarter with Smart 
Mailboxes. 

Note: If you dislike Mail’s entire approach to searching or find that it 
just doesn’t scratch your itch, you might consider a tool from Nisus 
Software called InfoClick. This app uses its own search engine and a 
unique interface to find Mail messages. It’s not my cup of tea, largely 
because it can’t search for phrases (such as “Take Control of Apple 
Mail”)—it treats every word independently. Your mileage may vary. 

Perform a Natural Language Search 

Here’s a novel idea: when you’re searching for email, just describe 
what you’re looking for in your own words. You can use plain English 
(or plain whatever-language-you-speak) in Mail’s Search field, as well 
as in system-wide Spotlight searches, to find email messages. 

Note: In Big Sur or later, if you don’t see the Search field in the 
toolbar, click the Search icon to display it; click the chevron 
icon to hide it again. 
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There’s no rulebook, no list of approved words or phrases. You just 
describe what you want. Here are some examples: 

• emails from John Smith 

• messages to John Smith 

• messages with “split pea” in the subject 

• email with “split pea” in the body 

• email from John Smith in the last week 

• mail from Morgen including photographs 

• mail I ignored from Adam 

• unread messages from this week 

• messages from bruce about security 

There are countless other ways to search using natural language, but 
the point is: don’t try to outthink Spotlight. Just ask the question that 
you’re thinking. 

Having said that, I should point out a few things I’ve noticed about 
natural-language searches in macOS Mail: 

• Results aren’t always exhaustive. For example, if I ask for 
unread messages, Mail shows me only recent unread messages. 
You should not assume that because a message doesn’t show up 
in a natural-language search, it doesn’t exist. 

• Mail doesn’t care about your wording. Notice how, in the 
examples above, I interchangeably used email, emails, mail, and 
messages. Mail knows those all mean the same thing. So, don’t get 
hung up on picking exactly the right term. 

• Mail is smart, but it can’t read your mind. If you search for 
messages from “Bob,” you may have a particular person in mind, 
but Mail doesn’t know which of the many Bobs in your saved mail 
you’re interested in. Be more specific if the results aren’t what you 
want. 
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Take Control of Your Inbox 
Does your Inbox contain hundreds of messages? Thousands? Tens 
of thousands? If so, you may find it nearly impossible to tell which 
messages you’ve dealt with and which still require action, and finding 
a particular message in that long list may be a daunting challenge. 
You need to take control of your Inbox! 

Although everyone’s different, I’d like to offer some suggestions that 
will help you manage the flow of incoming messages. I don’t particu-
larly care whether you do things my way, but please think carefully 
about the types of messages you receive and come up with a plan to 
deal with them that works for you. 

I begin this chapter with a series of pointers that apply equally to 
macOS (and other desktop platforms) and iOS/iPadOS. Then I discuss 
specific approaches for each platform in Develop an Email Strategy. I 
also talk briefly about how to Back Up and Restore Your Email and 
how to Import Email. 

Take Responsibility 

The first step to taking control of your Inbox is recognizing that you, 
and only you, bear the responsibility for making your own email 
manageable. If you feel overwhelmed by email, don’t point the finger 
at email as a medium—or at Apple Mail, your email provider, or your 
correspondents. You can make email work for you, but as with a diet 
or fitness program, it requires time, effort, and perhaps discomfort 
on your way to success. No app, service, or technique can do all that 
for you magically, even though such things can certainly help a bit. 

As I said in my TidBITS article It’s Not Email That’s Broken, It’s You, 
email as such isn’t the problem, but rather the bad habits many people 
have gotten into when it comes to dealing with their email. Perhaps 
your mother, like my mother, was fond of saying, “This room isn’t 
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going to clean itself up!” By the same token, I can assure you that elves 
will not appear overnight and answer all your delinquent email, file it 
away for you, and leave you with an empty Inbox. If you want to feel 
in control of your Inbox, that’s going to require some reflection, 
experimentation, and changes in habit. 

So, although I can’t solve this problem for you, I can offer some tips 
and suggestions that, I hope, will point you in the right direction. 
That’s what the remainder of this chapter is about. 

Consolidate Your Accounts 

Since you’re reading this book, I assume you have at least one email 
account. Maybe you have two (personal and work)—or maybe, like me, 
you have more than a dozen. My excuse is that I need to have accounts 
for almost every major type and provider for testing purposes because 
I write about email. But I know lots of people who accumulate ac-
counts (especially free accounts) for no particular reason and then end 
up wasting time and effort checking, managing, and maintaining them 
all. 

So, allow me to make a few suggestions to make your life simpler and 
to make Mail in macOS and iOS/iPadOS work better. 

Begin by choosing one account to be your primary personal email 
account. (Of course, you may need to keep work email separate, and 
that’s entirely reasonable.) Then, rather than send out change-of-
address notices to anyone who might have each of the other address-
es—assuming you can even remember who has which one—visit the 
web interfaces for all other accounts, set them up to forward incoming 
messages to your central account, and disable those accounts in Mail 
on your Macs and iOS/iPadOS devices. 

Once you’ve performed this one-time procedure, your correspondents 
can keep using your old addresses, but you benefit by having just one 
place to check for incoming mail and one place to store the messages 
you want to save. Having fewer accounts to check will make Mail 
peppier, too. 
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Become a Better 
Correspondent 

In the previous chapter, Take Control of Your Inbox, I looked at the 
ways you can improve your management of incoming email. In this 
chapter we look at the flip side: handling outgoing email. I felt it was 
important to spend a few pages on this topic, because anyone who 
doesn’t exercise care in sending email becomes part of the problem 
for other people dealing with their incoming mail. 

Lots of people are bad at email—you can probably think of a few 
examples immediately—and I want to make sure you’re not one of 
them. But even if you’re fantastic at sending email, I hope the points 
I make in this chapter help you to set a good example and teach other 
people how to improve their email skills. 

Don’t Be Part of the Problem 

The most common mistakes people make when sending email aren’t 
premeditated or malicious; they’re simply a matter of not thinking 
things through—of not looking at email from the recipient’s point of 
view. If your guiding principle is to send only email messages you’d be 
happy receiving yourself, you’re already well on your way to being a 
better correspondent. 

But what counts as email courtesy isn’t always obvious, so let me offer 
several specific tips: 

• Use Bcc for lists: When one of my sons was in preschool, I used 
receive email messages a few times a month sent to all the parents 
by a member of the parents’ association. And all 108 addresses were 
in the To field, which meant I had to scroll past them when viewing 
the messages on my iPhone before I got to the message body. It also 
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meant I knew every other recipient’s email address, which not 
everyone is comfortable sharing publicly. 

When sending a message to multiple people—especially a long list, 
and even more especially when they don’t know each other—put 
your own address in the To or Cc field, and put all the recipient 
addresses in the Bcc (blind carbon copy) field (see Message 
Header). That way, each recipient’s address is hidden from the 
other recipients. And they’ll thank you for it. 

• Be careful with Reply All and Cc: Suppose you’re the recipient 
of a message sent to multiple people, and their addresses are in the 
To or Cc fields. You might be tempted to click Reply All out of habit, 
but please think before you do. Does everyone else on that list really 
need to hear what you have to say, or just the sender? Or perhaps a 
subset of the recipients? You can individually delete email addresses 
when replying to all, and more often than not, replying to everyone 
on a long list amounts to unwanted clutter for most of them. 

Similarly, think before adding someone as a Cc recipient. People 
regularly Cc me on complaints, bug reports, and other matters that 
vaguely involve a book or article I’ve written, but really: I don’t need 
to be involved, and I assure you that putting my name on a message 
you send to Apple (or whomever) won’t lend it any more weight. 
Ask yourself whether the potential Cc recipient truly needs to be 
involved in a discussion. 

• Don’t forward nonsense: Jokes, funny animal pictures, political 
screeds, and other such stuff that gets endlessly forwarded is nearly 
as bad as spam. You can’t stop someone from sending this material 
to you (although you can ask politely), but you can certainly make 
sure you’re the last link in the chain. Seriously, no matter how funny 
or apt you find one of these generic messages, your friends and 
family don’t need to read it. 
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Sign and Encrypt Messages 
Back in Signatures, I explained how to add a signature to the end of 
each message with your contact information, a quote, or other content. 
But a message can also have a digital signature, a (normally invisible) 
string of characters that confirms to the recipient that the message 
truly comes from the address it appears to come from, and that the 
message contents haven’t been altered in transit. 

In addition, Mail can encrypt messages, scrambling their contents so 
that only someone with the necessary key (presumably, the recipient) 
can view their contents, thereby ensuring private communications. 

In this chapter I discuss if and when you should use digital signatures 
and encryption, how they work behind the scenes, and how to go about 
signing and encrypting messages in Mail. 

Learn When and Why to Sign or 
Encrypt Messages 

Let me start with the essential question of whether, or under what 
circumstances, you should even think about signing or encrypting 
messages. It’s not something everyone needs to do, and if you never 
need to do it, you need not bother reading the rest of this chapter. But 
the need could arise at some point—and even if you don’t need to sign 
or encrypt, you may find that there are some benefits to doing so. 

Note: One could argue that even though most email doesn’t need to 
be encrypted, using encryption routinely (even when not needed) is a 
smart idea. If you encrypt only certain messages, that could suggest 
to an attacker that you have something to hide, and that those 
encrypted messages are where it’s hidden. 

Most of us are accustomed to thinking of email as being private. One 
person sends a message and someone else receives it; as long as no 
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one is looking over either person’s shoulder or snooping on their 
computers when they’re not around, we presume that whatever was 
in that message is known only to the sender and recipient. 

Indeed, that’s how things work most of the time, just as with paper 
letters: Most of the time no one except the intended recipient opens 
a letter to see what’s inside. But mail theft, tampering, accidents, 
and honest mistakes do occur. It sometimes happens that a person 
who shouldn’t see what’s inside an envelope, does. And when the 
contents of that envelope are highly confidential, sensitive, or valuable, 
someone else reading your mail can become a serious problem indeed. 

Email is no different. It should be private, but it isn’t always. Each 
message exists not only on the computers of the sender and recipient, 
but also (at least temporarily) on each party’s mail server. In addition, 
a message may pass through any number of intermediate servers and 
routers, and may be backed up along the way in the data centers of 
one or more ISPs. In any of these places, a message could be read by 
an employee of the ISP, and it could be intercepted in transit by a 
hacker—or a government agency—during its journey. 

(“Doesn’t SSL encrypt my messages?” you may ask. SSL secures a 
message only between Mail and the incoming or outgoing mail server, 
but doesn’t prevent someone from reading that message while it’s on 
a mail server, or during other legs of the delivery process.) 

Because so many millions of email messages are exchanged every day, 
the probability that any particular message you send or receive will be 
read by someone who shouldn’t see it is incredibly small—but not zero. 
So, consider what would happen in one of these situations if the wrong 
person read email you sent: 

• You need to email your accountant detailed information about your 
income, expenses, and taxes. 

• You need to provide someone with your credit card number, social 
security number, or other sensitive information by email. 
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Fix Mail Problems 
As I said earlier in this book, the macOS version of Mail has a number 
of reliability and behavior problems, and many of them are things you 
can’t fix, because you didn’t do anything to cause them—only Apple 
can fix them. So, although I can’t offer solutions to every problem, I’ve 
compiled solutions to some of the most common (and serious) prob-
lems in the pages ahead, including difficulties receiving and sending 
mail, problems with damaged mailboxes, and misbehaving Spotlight 
searches. 

Although some of this information may provide useful background 
for resolving issues in Mail in iOS/iPadOS too, the specifics are differ-
ent; see Troubleshoot iOS & iPadOS Mail Problems for help with Mail 
in iOS and iPadOS. 

Fix Incoming Mail Problems 

If Mail cannot download incoming messages, the cause may be any-
thing from an incorrect setting in Mail, to a server problem, to a loss 
of internet connectivity. Work through each of the following sections 
until you resolve the problem. 

About the Activity Window 
To check what Mail is doing behind the scenes, choose Window > 
Activity. A small floating window appears, displaying detail about each 
activity Mail is performing. If there’s only one activity (and I’ve never 
seen more than two at once), the mini activity monitor at the bottom 
of the sidebar shows the same information. Unfortunately, the Activi-
ty window no longer lets you cancel tasks, as was the case in 
Yosemite and earlier. 

For these two reasons, there’s little point in using the Activity window 
anymore—just look at the mini activity monitor in the sidebar. 

195 

Click here to buy the full 261-page “Take Control of Apple Mail” for only $14.99!

https://www.takecontrolbooks.com/cart/?add-to-cart=1171


          
         

       
             

             
            

           
             

    

   
             

        
           

           
       

         
          

            
         

            
             
   

          
          
        

           
           

            
      

           
           

Try Connection Doctor 
To open Connection Doctor, choose Window > Connection Doctor. In 
the Connection Doctor window, Mail lists each incoming and outgoing 
email account you’ve configured—even those you’ve temporarily 
disabled. It attempts to log in to each account, and if it fails with any 
of them, it shows an explanation of why it failed. These explanations 
aren’t always helpful, but they often give you a good starting point 
in debugging problems, and are written in refreshingly plain English. 
If the Connection Doctor window suggests a specific fix, try that first. 
Otherwise, proceed with the following steps. 

Username and Password Errors 
If you enter your password in Mail > Preferences > Accounts (or in 
System Preferences > Internet Accounts), macOS stores the password 
in your keychain (which is usually what you want). If, for security 
reasons, you prefer for Mail to prompt you for your password each 
time you connect, leave the Password field blank. 

Sometimes, even after successfully checking your email many times 
with the password you entered, Mail displays a dialog claiming that 
the mail server has “rejected” your password. Worse, you may re-enter 
your password—and even select “Remember this password in my 
keychain”—but find that another error message pops up as soon as you 
click OK. This annoyance may be due to any number of causes, but 
most have simple solutions. 

If Mail suddenly begins prompting you for your password repeatedly 
when checking incoming mail (after retrieving it correctly earlier), try 
these steps in order until the problem goes away: 

1. Click Cancel, wait a minute, and check your email again. Sometimes 
the problem goes away on its own—most likely because of a glitch 
with the server or your connection to it. (If your account is offline, 
choose Mailbox > Take All Accounts Online.) 

2. If the problem persists, return to Keychain Access. Make sure that 
Passwords or All Items is selected under Category, locate your mail 
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Use Mail in iOS & iPadOS 
So far, the bulk of this book has been about Mail on a Mac. Although 
I’ve mentioned Mail for iOS and iPadOS from time to time (and some 
of the things I’ve discussed apply equally to all platforms), Mail in iOS/ 
iPadOS has enough unique characteristics that it deserves its own 
chapter. As was the case for macOS Mail, I’m not going to cover every 
feature here. Instead, I want to point out the most important things 
you need to understand in order to use Mail for iOS and iPadOS 
effectively—especially aspects of Mail that are unclear, obscure, or 
otherwise confusing. 

I begin with a list of the key differences between Mail in macOS and 
Mail in iOS/iPadOS. Then I move on to Configure Mail in iOS & 
iPadOS and wrap up with how to Troubleshoot iOS & iPadOS Mail 
Problems. 

Mail in iOS & iPadOS vs. Mail in macOS 

Mail in iOS and iPadOS shares a great deal in common with Mail on a 
Mac, so anyone accustomed to one platform should be able to pick up 
the other easily. Naturally, the iOS/iPadOS version makes accommo-
dations for smaller screens, a touch-screen interface, and the numer-
ous user interface conventions that differ from those of macOS. I won’t 
spell all those out here, but I do think it’s worth pointing out several 
key differences in functionality—as well as a few similarities you may 
not have noticed. 

Here’s what you should know about the iOS/iPadOS version of Mail: 

• No rules or spam filtering: If you want to sort messages or weed 
out junk mail automatically, it’s best to set these tasks up on your 
mail server. (See Use Rules and Control Spam, respectively.) 

• Push (but no IMAP IDLE): Mail in iOS and iPadOS supports 
push delivery of messages from iCloud, Exchange, and Yahoo IMAP 
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accounts—and push works even when Mail isn’t open (see Fetch, 
Push, and IMAP IDLE). However, IMAP servers that offer only 
IMAP IDLE as a way of “pushing” messages don’t give you push 
delivery on an iOS device. As a result, Mail in macOS is likely to 
display messages from such servers before Mail in iOS/iPadOS. 

Push delivery, where applicable, works with your Inbox and—for 
iCloud and Exchange accounts only—with other mailboxes you 
explicitly set up (see Change Account Settings). 

In addition, note that even with iCloud and Exchange accounts, 
although Mail pushes new messages to your device immediately, 
it does not push changes made on other devices, such as moved 
or deleted messages. So, if your Mail icon in iOS/iPadOS says you 
have one unread message, and you delete that message on your 
Mac, the “1” badge won’t disappear right away; you may need to 
open Mail to force it to resynchronize its Inboxes. 

• Limited mailbox syncing: Related to the last point…whereas the 
macOS version of Mail caches complete copies of all messages in all 
IMAP and Exchange mailboxes, syncing them in the background, 
Mail for iOS/iPadOS doesn’t (which is a good thing, because that 
would chew up lots of cellular bandwidth and storage space). 

Instead, for IMAP accounts, Mail syncs only the Inbox in the back-
ground. For Exchange accounts, you can specify how far back to 
sync email messages (from a day to a month, or all messages), and 
as I mentioned in the previous point, you can select, for iCloud and 
Exchange accounts, which mailboxes should have their messages 
pushed to your device. As for any other mailboxes, Mail syncs them 
only when you tap on them to display their contents. 

This may be significant if you use server-side filters or rules to sort 
your messages into mailboxes, because mailboxes other than Inbox 
won’t indicate that they contain any new, unread messages until you 
manually select them. 

• Autocomplete for multiple addressees: If you regularly send 
messages to the same set of addresses (for example, your spouse 
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About This Book 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments. 

Ebook Extras 

You can access extras related to this ebook on the web. Once you’re 
on the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy 
a subsequent edition at a discount. 

• Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

• Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

• Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control website, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. 
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Also by Joe Kissell 
Click any book title below or visit our web catalog to add more ebooks 
to your Take Control collection! 

Take Control of 1Password: Slowed down by entering passwords 
repeatedly? Learn how to let 1Password do the heavy lifting. 

Take Control of Automating Your Mac: Work more efficiently on your 
Mac with time-saving shortcuts of all kinds. 

Take Control of Backing Up Your Mac: Protect your valuable data with 
a complete, bulletproof backup strategy. 

Take Control of DEVONthink 3: Master this powerful information 
management tool. 

Take Control of iCloud: Understand the many features, get set up 
properly, and enjoy iCloud! 

Take Control of Monterey: Discover what’s new in macOS 12 and get 
all the information you need to upgrade safely. 

Take Control of the Cloud: Wrap your head around the wide variety of 
cloud services and apps, and make smart purchasing decisions. 

Take Control of the Mac Command Line with Terminal: Master your 
Mac’s command-line interface and learn basic Unix skills. 

Take Control of Your Digital Legacy: Make sure your important 
digital information is preserved for future generations. 

Take Control of Your Online Privacy: Learn what’s private online (not 
much)—and what to do about it. 

Take Control of Your Paperless Office: With your Mac and a scanner, 
you’ll clear the chaos of an office overflowing with paper. 

Take Control of Your Passwords: Overcome password overload 
without losing your cool. 
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Copyright and Fine Print 
Take Control of Apple Mail, Fifth Edition 
ISBN: 978-1-990783-09-8 
Copyright © 2022, Joe Kissell. All rights reserved. 

alt concepts, 419 8B-3110 8th St. East, Saskatoon, SK S7H 0W2 Canada 

Why Take Control? We designed Take Control electronic books to help readers regain 
a measure of control in an oftentimes out-of-control universe. With Take Control, we also 
work to streamline the publication process so that information about quickly changing 
technical topics can be published while it’s still relevant and accurate. 

Our books are DRM-free: This ebook doesn’t use digital rights management in any 
way because DRM makes life harder for everyone. So we ask a favor of our readers. If you 
want to share your copy of this ebook with a friend, please do so as you would a physical 
book, meaning that if your friend uses it regularly, they should buy a copy. Your support 
makes it possible for future Take Control ebooks to hit the internet long before you’d find 
the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any 
free updates that become available. 

Remember the trees! You have our permission to make a single print copy of this 
ebook for personal use, if you must. Please reference this page if a print service refuses 
to print the ebook for copyright reasons. 

Caveat lector: Although the author and alt concepts have made a reasonable effort 
to ensure the accuracy of the information herein, they assume no responsibility for errors 
or omissions. The information in this book is distributed “As Is,” without warranty of any 
kind. Neither alt concepts nor the author shall be liable to any person or entity for any 
special, indirect, incidental, or consequential damages, including without limitation lost 
revenues or lost profits, that may result (or that are alleged to result) from the use of these 
materials. In other words, use this information at your own risk. 

It’s just a name: Many of the designations in this ebook used to distinguish products 
and services are claimed as trademarks or service marks. Any trademarks, service marks, 
product names, or named features that appear in this title are assumed to be the property 
of their respective owners. All product names and services are used in an editorial fashion 
only, with no intention of infringement. No such use, or the use of any trade name, is 
meant to convey endorsement or other affiliation with this title. 

We aren’t Apple: This title is an independent publication and has not been authorized, 
sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses 
terms that are registered trademarks or service marks of Apple Inc. If you’re into that sort 
of thing, you can view a complete list of Apple Inc.’s registered trademarks and service 
marks. 
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